
What is Cookie Pal?
Cookie Pal is a complete internet cookie management system for Windows 95 and
Windows NT 4.0. Cookie Pal works with you web browser to give you complete
control over the cookies which are accepted by and stored on your system.

Cookie Pal works with the following web browsers:
· Microsoft Internet Explorer 3.x
· Netscape Navigator 3.x
· Compuserve WinCIM 3.01
· Microsoft Internet Explorer 4.0 platform preview release
· Netscape Navigator 4.0 preview release

Cookie Pal includes the following features:

· Automatically and transparently accepts or rejects cookies from specified servers without user 
interaction.

· Cookies received from unspecified servers can be automatically accepted or rejected without user 
interaction, or the user can be asked for confirmation.

· "On the fly" adding of servers to the accept from and reject from lists, allows you to manually accept or
reject a cookie once and subsequently accept or reject it every time it is received. 

· Keeps a list of the number of cookies accepted and rejected from each server for the current session.
· Allows all cookies already on the system to be viewed and deleted.
· Detects when your web browser is loaded and starts working right away. 
· Runs as an icon in the taskbar tray.
· Full 32 bit application, written in C++.

Why use Cookie Pal?
Both Netscape Navigator and Microsoft Internet Explorer contain options to alert the user before a cookie 
is accepted. This causes the browser to pop up an alert every time a cookie is received and the user must
respond to this alert before continuing. Some web pages can contain up to 20 or 30 cookies, meaning a 
lot of annoying confirmations for the user. Cookie Pal intercepts these alerts that would normally be 
displayed and responds to them on your behalf before they are even displayed on screen - your only clue 
that a cookie has been accepted or rejected will be a brief change in the task bar icon for Cookie Pal.



What is a cookie?
A cookie is a piece of data which is stored on your local computer by a web site that you have visited 
using your web browser. The data that is stored is then sent back to the web site every time you visit that 
site. The data can contain information such as a user name and password for that site, items you are 
purchasing on a shopping site, or any other information the web site desires.

Why should I be concerned about cookies?
There has been a lot of coverage in the press about cookies and potential privacy issues. The main issue 
is that web sites can keep track of your movements on their site by using cookies, so that they will know 
exactly where you have and have not been. They are increasingly used by companies and advertisers to 
monitor and accumulate internet user data. Many people feel that this is an invasion of privacy.

How does Cookie Pal help?
Cookie Pal helps by automatically responding to requests to store cookies on your computer. It is 
especially useful because you can set up lists of sites that you do and do not want to accept cookies from,
and then Cookie Pal can respond automatically when a cookie is received from those specific sites. This 
allows you to accept cookies from certain sites (some shopping sites for example will not work correctly 
without cookies, or you may need to accept cookies from web addresses on your company LAN), rather 
than just rejecting all cookies which come your way, although this too can be done with Cookie Pal.



Browser options
Normally you will not need to change any browser options in order for Cookie Pal to work correctly. If you 
install Cookie Pal using its installation program then Cookie Pal will make all necessary adjustments for 
you so that it can run correctly.

However, there is an option which you must make sure stays enabled for Cookie Pal to work. Both 
Netscape Navigator and Microsoft Internet Explorer have options which cause an alert to be displayed 
before a cookie is accepted by the browser. This option must be enabled in order for Cookie Pal to work. 
When you install Cookie Pal it automatically enables these options and whenever Cookie Pal is started it 
also enables these options so you should never have to change them yourself, but if you do here is what 
to do:

Microsoft Internet Explorer 3.x
1. Select the Options… command from the View menu in Internet Explorer.
2. Click on the Advanced tab of the dialog box which appears.
3. To enable warning messages ensure that the "Warn before accepting cookies" option is    checked. To

disable warning messages ensure that this option is not checked.
4. Click OK to close the dialog box and store the options.

Netscape Navigator 3.x
1. Select “Network Preferences…” from the Options menu.
2. Select the Protocols tab of the dialog which appears.
1. To enable warning messages ensure that the "Accepting cookies" option is checked. To disable 

warning messages ensure that this option is not checked.
1. Click OK to close the dialog box and store the options.

Microsoft Internet Explorer 4.0
1. Select the "Options…" command from the View menu in Internet Explorer.
2. Click on the Advanced tab of the dialog box which appears.
3. Scroll down the list until you see the option "Do not warn before accepting Cookies", under the 

"Warnings" heading.
4. To enable warning messages ensure that this option is not checked. To disable warning messages 

ensure that this option is checked.
5. Click OK to close the dialog box and store the options.

Netscape Navigator 4.0
1. Select “Preferences…” from the Edit menu.
2. Click on the word "Advanced" in the category list on the left side of the dialog.
3. To enable warning messages ensure that the "Warn me before accepting a cookie" on the right hand 

side of the dialog is selected. To disable warning messages, select either the "Always accept cookies"
or "Never accept cookies" options.

4. Click OK to close the dialog box and store the options.



How does Cookie Pal work?
Cookie Pal works by intercepting the message box which would normally be displayed by your browser to
alert you of a cookie which has been received. Cookie Pal detects this message box before it is even 
displayed on screen, so if you are automatically handling cookies which are received then Cookie Pal will 
respond to this message box for you and it will disappear without you seeing anything on screen.

Because of the way Cookie Pal works it is very important that your browser is configured to display 
an alert when a cookie is received. Cookie Pal will enable this option for whichever browser you are 
using by default but if you need to change this option yourself for any reason, see the help topic title 
Browser options for information on how to do this.



Using the Cookie Pal taskbar tray icon 
When you run Cookie Pal, an icon is added to the taskbar tray (in the bottom right corner of the screen) 
which can be used to interact with Cookie Pal. The taskbar icon minimizes Cookie Pal’s screen usage 
while running and can make its usage almost transparent.

The icon will appear as a small cookie in the taskbar tray and will appear different depending on the state 
of Cookie Pal as follows:

This icon appears when Cookie Pal is not monitoring any browsers.
This icon appears when Cookie Pal is monitoring cookies for a browser.
This icon appears briefly when Cookie Pal accepts or rejects a cookie.
This icon appears if Cookie Pal is disabled.

Displaying the main window
The main Cookie Pal window is not initially displayed when you start Cookie Pal. To display the main 
window you can either double click on the Cookie pal tray icon, or you can right click on the Cookie Pal 
tray icon and select the Show command from the pop-up menu.

Hiding the main window
If the main window is currently displayed, you can click the minimize button in the main window to hide it. 
Alternatively you can double click on the Cookie Pal tray icon, or you can right click on the Cookie Pal tray
icon and select the Hide command from the pop-up menu.

The tray icon menu
Clicking on the tray icon with the right mouse button will display a pop-up menu. This menu has the 
following commands on it:

Show/Hide This option will either show or hide the main Cookie Pal window. If the 
window is displayed, clicking the minimize button on the window will also 
hide it.

Disable/Enable This option will either disable or enable Cookie Pal. This allows you to 
disable Cookie Pal's functionality without shutting it down. When disabled
a different icon will appear in the taskbar tray and Cookie Pal will no 
longer intercept cookies from your browser. This means that you will see 
the default browser warning message whenever a cookie is received. 
Select the Enable command to activate Cookie Pal again.

Exit This option will shut down Cookie Pal.
About This option will display the program copyright message, version number 

and registered user information.



The main Cookie Pal window
The main Cookie Pal window can be displayed by either double clicking on the taskbar tray icon or by 
right clicking the tray icon and selecting the Show option from the pop-up menu. When the main window 
is displayed it can be hidden again by minimizing it, by double clicking on the taskbar tray icon again or by
right clicking the tray icon and selecting the Hide option from the pop-up menu.

Closing the main window (using the X button in the top-right corner) will shut down Cookie Pal, just the 
same as using the Exit command from the taskbar tray icon.

The main Cookie Pal window contains several tabbed pages which display different information and let 
you accomplish different maintenance tasks. You can click on the tab for each page to display that page. 
The following tabs are displayed:

Session This tab displays the web sites from which cookies have been received in the 
current session.

Filters This tab display a list of filters. Filters allow you to specify web sites from which 
you wish to accept and reject cookies. You can also specify what to do with 
cookies received from web sites for which you do not have a specific filter set up.

Cookies This tab displays a list of cookies which are already stored on your computer for 
both Netscape Navigator and Internet Explorer. You can view the cookies and 
delete them if you wish.

Configure This tab allows you to configure Cookie Pal. You can define the text which Cookie
Pal uses to recognize cookie alerts displayed by your browser. This is set up by 
default for English language versions of these browsers, but may be different for 
other languages.

The main window also contains the following buttons along the bottom of the window:

Ordering… This button displays a help topic with information about how to order Cookie Pal.
Register… This button displays a dialog box which allows you to enter your registration 

information once you have registered your copy of Cookie Pal.
About… This button displays the program copyright message, version number and 

registered user information.
Help This button displays a help topic for the tab which is currently displayed    in the 

main window.



The Session page
The Session page can be displayed by selecting the Session tab in the main Cookie Pal window. This 
page displays a list of web sites (or servers) from which cookies have been received for the current 
session (i.e. since Cookie Pal has been started).

The list displays the following columns:

Server This column displays the name of the servers or web sites which have attempted 
to set a cookie. The name is a web site domain name or IP address and will often
begin with www.

# Accepted This column displays the number of cookies which have been accepted (either 
manually or automatically) from this server for the current session.

#Rejected This column displays the number of cookies which have been rejected (either 
manually or automatically) from this server for the current session.

Time This column displays the time at which the last cookies was received from this 
server. By sorting on this column you can easily see the most recent web sites 
which have attempted to set cookies on your computer.

Sorting the list
You can click on any of the buttons at the top of each column to sort the list by that column. Clicking on 
the same button a second time will reverse the order that the items are listed in. A plus or minus sign (+ or
-) will be displayed on the button for the column by which the list is sorted.    For example, you can click on
the Server button to sort the list in order of server name. A plus sign will then appear after the word Server
to indicate that the list is sorted in increasing order of server name. If you then click on the Server button 
again, the list will be sorted in decreasing order by server name and a minus sign will be displayed after 
the word Server on the button.



The Filters page
The Filters page can be displayed by selecting the Filters tab in the main Cookie Pal window. This page 
displays two lists of web sites (or servers) from which cookies will be automatically accepted or rejected. 
In addition you can specify how cookies from servers which are not in these lists should be handled on 
this page.

The lists contain server or web site names in the form of their domain names or IP addresses. For 
example you could add www.microsoft.com to the reject list to always reject any cookies you receive from
the Microsoft web site. Or you could add 200.100.100.1 to the accept list to always accept cookies from 
the web server at address 200.100.100.1 (which might be on the internet or your company LAN).

The easiest way to maintain these lists is by using the Ask for confirmation radio button which allows 
you to add server to these lists on the fly as cookies are received. See the Cookies from unknown servers
topic below for more information.

Accept cookies from:
This list displays the servers from which you wish to always accept cookies. You can click on the New 
button below this list to add a new server to the list, or you can select a server from the list and click on 
the Delete button below the list to delete a server from the list.

Reject cookies from:
This list displays the servers from which you wish to always reject cookies. You can click on the New 
button below this list to add a new server to the list, or you can select a server from the list and click on 
the Delete button below the list to delete a server from the list.

Cookies from unknown servers
The radio buttons in this group allow you to specify what should be done when a cookie is received from a
server which is not in either of the two lists above. You can choose from the following three options:

Reject all Selecting this option will cause Cookie Pal to automatically reject (without
any user intervention) any cookies received which are not in the Accept 
cookies from: list. This allows you to set up a list of web sites from which 
you want to accept cookies and then reject any other cookies which are 
received.

Accept all Selecting this option will cause Cookie Pal to automatically accept 
(without any user intervention) any cookies received which are not in the 
Reject cookies from: list. This allows you to set up a list of web sites from
which you want to reject cookies and then accept any other cookies 
which are received.

Ask for confirmation Selecting this option will cause Cookie Pal to display a message box 
whenever a cookie is received which is not in either of the two lists 
above.    When such a cookie is received a dialog box will be displayed 
with four buttons allowing the user to choose what to do with the cookie. 
The dialog will display information about the cookie and then will ask 
whether or not you want to accept the cookie. You can answer using one 
of the following buttons in this dialog box:

Yes Selecting Yes will accept the cookie just this one time. If the cookie is 
received again in the future you will be prompted again.

No Selecting No will reject the cookie just this one time. If the cookie is 
received again in the future you will be prompted again.

Always Selecting Always will accept the cookie and then add the name of the 
server from which the cookie was received to the Accept cookies from 
list. Whenever any cookies are received from this server in the future, 
they will be automatically accepted with no further user interaction.



Never Selecting Never will reject the cookie and then add the name of the 
server from which the cookie was received to the Reject cookies from 
list. Whenever any cookies are received from this server in the future, 
they will be automatically rejected with no further user interaction.



The Cookies page
The Cookies page can be displayed by selecting the Cookies tab in the main Cookie Pal window. This 
page displays a list of cookies which are currently stored on your computer. The server (or web site) the 
cookie was received from, the cookie name and cookie value are displayed. You can use the radio 
buttons to display cookies stored by Netscape Navigator or by Internet Explorer. You can also delete any 
cookies that you want to.

The Cookies list displays the following columns:

Server This column displays the domain name of the server from which the cookie was 
received and which it will be sent back to. The server name is a web site domain 
name or IP address and will often begin with www.

Name This column displays the name of the cookie.
Value This column displays the value assigned to the cookie.

Sorting the list
You can click on any of the buttons at the top of each column to sort the list by that column. Clicking on 
the same button a second time will reverse the order that the items are listed in. A plus or minus sign (+ or
-) will be displayed on the button for the column by which the list is sorted.    For example, you can click on
the Server button to sort the list in order of server name. A plus sign will then appear after the word Server
to indicate that the list is sorted in increasing order of server name. If you then click on the Server button 
again, the list will be sorted in decreasing order by server name and a minus sign will be displayed after 
the word Server on the button.

You can use the other controls in this page as follows:

Netscape
Selecting this radio button will display the cookies stored on your computer by Netscape Navigator in the 
cookies list.

Internet Explorer
Selecting this radio button will display the cookies stored on your computer by Microsoft Internet Explorer 
in the cookies list.

Delete
This button will delete the cookie which is currently selected in the list above. The cookie will be 
permanently deleted from your computer. 

Refresh
This button will read the cookies again from disk and display the newly read cookies in the list above. 
Internet Explorer stores cookies as they are received, so if cookies have been received since you first 
displayed this list you can press the Refresh button to read the new cookies which have been stored. 
Netscape Navigator only stores the cookies permanently when it shuts down, rather than as they are 
received, so you will only see any new cookies after Navigator is shut down and you then click the 
Refresh button.



The Configure page
The Configure page can be displayed by selecting the Configure tab in the main Cookie Pal window. This 
page allows you to define the text which Cookie Pal uses to recognize cookie alerts displayed by your 
browser. This is set up by default for English language versions of these browsers, but may be different 
for other languages.

Note that for all text options on this page, as soon as you use the tab key to move out of an edit field, or 
click in another edit field or on another control, the text you have entered will be stored permanently and 
used by Cookie Pal immediately, so you do not need to select a button or other option to store the 
settings you have specified. 

Netscape

Cookie window title
Enter the text which appears in the title bar (or caption) of the message box which is displayed by
Netscape Navigator when a cookie has been received. This text must match exactly (including 
case) the text used in the title bar.

Expiration date text
When Navigator displays a cookie alert, it displays the expiration date of the cookie if it has one. 
In the English language version this is displayed directly after the text "persist until", as in "This 
cookie will persist until Mon Dec 01 1997 GMT". You must enter here the unique text which 
appears immediately before the expiration date in the cookie alert dialog which is displayed by 
Netscape Navigator when a cookie is received.

Internet Explorer

Cookie window title
Enter the text which appears in the title bar (or caption) of the message box which is displayed by
Internet Explorer when a cookie has been received. This text must match exactly (including case) 
the text used in the title bar.

Expiration date text
When Internet Explorer displays a cookie alert, it displays the expiration date of the cookie if it 
has one. In the English language version this is displayed directly after the text "It expires on", as 
in "It expires on Mon Dec 01 1997 GMT". You must enter here the unique text which appears 
immediately    before the expiration date in the cookie alert dialog which is displayed by Internet 
Explorer when a cookie is received.

Cookie text
You must enter the word "cookie" as displayed by Netscape Navigator and Internet Explorer in each of 
their cookie alert dialog boxes. If Cookie Pal does not find this word contained in the text of the alert 
dialog box then it will not intercept the dialog box and it will be displayed as normal.

Disable alert sound
If you have a sound card installed in your system you may want to select this option. Normally when 
Navigator or Internet Explorer display a cookie alert message you will hear a sound as the message box 
is displayed. When Cookie Pal intercepts the message box it cannot prevent the sound from being played
at that time. Selecting this option will cause Cookie Pal to permanently disable the sound while both 
Cookie Pal and a web browser are running . The side effect of this is that it will disable the sound for all 
similar message boxes displayed by any other applications in your system. The sound is only disabled 
while Cookie Pal and a browser are running if this option is checked. When you close your browser or 
Cookie Pal the sound setting will be restored in the registry.

Defaults



This button will reset all of the text options in this dialog box to their default English language values. If 
you select this you will lose any overrides you may have entered and will have to enter them again.



What is Registration?
Cookie Pal is a “Shareware” program. This means that you are free to use the software for up to 30 days 
free of charge for evaluation purposes. If you decide to keep the software after 30 days then you must 
register your copy with Kookaburra Software for a small fee.

The shareware (or unregistered) version of Cookie Pal contains all of the functionality of the registered 
version. This allows you to make sure that it works satisfactorily for you before you purchase the software.

When you register Cookie Pal the nag screen which is displayed when you start the program will be 
removed. In addition registration entitles you to free technical support and minor upgrades to the 
software. And don’t forget that registering this and other shareware programs allows the authors to 
continue development on those and new products.

Click here to find out how to register.



How to Register Cookie Pal

The registration fee for a single copy license of Cookie Pal is US$15.

When you place an order you will receive by return e-mail or regular mail a product registration number. 
You must then enter your name and this registration number into your existing copy of Cookie Pal using 
the Registration dialog box, which is accessed by selecting the Register option from the Cookie Pal main 
window. You should keep your registration number safe, so that you can re-enter it if you need to re-
install Windows or if you upgrade to a new computer at any time in the future.

Ordering by check
To order by check print and send the order form and a check to Kookaburra Software. Instructions for 
ordering by check are included on the order form. Payment must be in US dollars drawn on a US bank, 
or you can send international postal money orders in US dollars. Your registration information will be sent 
to you via e-mail or post.

Ordering through Compuserve
To order on the Compuserve online service and have the registration fee added to your CompuServe bill 
use the CompuServe command GO SWREG (click on the traffic light icon or the Go button in WINCIM 
and enter SWREG) and follow the menus.    You can search on the keyword Kookaburra or Cookie Pal. 
The Compuserve registration ID for Cookie Pal is 15107.
Your registration information will be electronically mailed to your CompuServe account within a few 
business days.

Ordering by Credit Card
For information on ordering by credit card, click here: Credit Card Ordering Information. 
Your registration information will be sent to you via e-mail or post.

Site licenses
A site license for Cookie Pal entitles an organization to receive a single product registration number and 
use it to register Cookie Pal on the specified number of computers. Site license pricing is indicated below. 
Note that site licenses cannot currently be purchased when ordering through Compuserve - you must 
choose one of the other ordering methods. All prices listed are in US$.

 2 to      9 computers: $13 each
10 to 24 computers: $11 each
25 to 49 computers: $9 each

50 or more computers: $7 each



Credit Card Ordering
You can order with MasterCard, Visa, American Express, or Discover through PsL. 

Note that credit card orders are taken through PsL, an independent company which 
provides a credit card ordering service only - if you have any questions regarding the 
status of your order after it has been placed with PsL, please contact Kookaburra 
Software directly. The best way to contact us for order status information is to send e-
mail to orders@kburra.com. For other inquiries regarding Cookie Pal please send e-mail 
to support@kburra.com

The best ways to reach PsL are:

· Online: Go to our Web site at http://www.kburra.com and follow the links for online ordering. A 
secure form is available for your protection.

· FAX: To 713-524-6398.    You can use the order form below. Please be sure to ask for product 
#15218 and please type or block print very plainly. 

· Email: To PsL at 15218@pslweb.com
· Mail credit card orders to PsL at P.O.Box 35705, Houston, TX 77235-5705. 
· Phone: PsL's operators are available from 8:00 a.m. to 6:00 p.m. CST Monday-Friday at the 

following numbers: 
800-242-4775 Ext.15218 
713-524-6394 Ext.15218

THE ABOVE NUMBERS ARE FOR CREDIT CARD ORDERS ONLY.
THE AUTHOR OF THIS PROGRAM CANNOT BE REACHED AT THESE NUMBERS.

CONTACT KOOKABURRA SOFTWARE DIRECTLY FOR ALL OTHER SUPPORT OR INFORMATION
REQUESTS.

When you contact PsL they will require the following information:

Product Name: Cookie Pal
Product ID: 15218
Your Name: ______________________________________

Company: ______________________________________

Your E-Mail Address: ______________________________________

Credit Card [ ] MasterCard      [ ] VISA      [ ] AMEX      [ ] Discover

Credit Card Number: ______________________________________ 

Expiration Date: ______________________________________ 

Name On Card: ______________________________________ 

Billing Address: ______________________________________ 

______________________________________ 

Qty. Required: ________

Please ensure that the credit card number and expiration date are provided and are written clearly 
if ordering by fax or mail.
                                                                                                                  
Any questions about the status of the shipment of the order, registration options, product details, technical
support, volume discounts, dealer pricing, site licenses, non-credit card orders, etc, must be directed to 
Kookaburra Software, P.O. Box 23200-394, San Jose, CA 95153 or by internet e-mail to 



orders@kburra.com.

PsL will notify us the day that they receive your order and we will send your registration number to you.



Cookie Pal Order Form
This order form is for ordering by check or money order only.

To print this order form click the Print button above or select the Print Topic option on the File pull-down 
menu.

These prices are guaranteed through September, 1997. An up-to-date version of Cookie Pal can be 
obtained from the Kookaburra Software web-site at www.kburra.com. 

Send this order form to: Kookaburra Software
P.O. Box 23200-394
San Jose,    CA      95153
U.S.A.

Name: _______________________________________________

Company: _______________________________________________

Address: _______________________________________________

City: _______________________________________________

State/Province: _______________________________________________

Zip/Post Code: ____________________      Country: __________________

Phone: (daytime) _______________ (evening)________________

E-Mail Address: _______________________________________________

Order Information

Cookie Pal Single Copy License
I would like to register _______ copies of Cookie Pal at $15 each 

=
_______

Cookie Pal Site License - For companies or organizations
2 to      9 computers: _______ computers at $13 each = _______
10 to 24 computers: _______ computers at $11 each = _______
25 to 49 computers: _______ computers at $9 each = _______

50 or more computers: _______ computers at $7 each = _______

Total payment enclosed: $ _______

Payment must be in US dollars drawn on a US bank, or you can send international postal money orders 
in US dollars. Make checks payable to Kookaburra Software.

How did you hear about Cookie Pal? ______________________________________

Comments:



How to enter your registration number

You can enter your registration number (obtained by registering your copy of Cookie Pal) using the 
Register dialog. The Register dialog can be displayed by selecting the Register option from the main 
window of Cookie Pal, or by clicking on the Cookie Pal tray icon with the right mouse button and selecting
the "Register…" option from the pop-up menu.

Name
Enter your name as it appears on your registration notice from Kookaburra Software. You must enter you 
name exactly as it appears on this notice.

Registration Number
Enter your registration number exactly as it appears on your registration notice from Kookaburra 
Software.

Once you have entered your registration information correctly and selected OK, your copy of Cookie Pal 
will be registered. You must save your registration information (name and number) as you will need to
re-enter it if you re-install Windows or if you upgrade to a new computer.



Support options
Kookaburra Software currently provides technical support to registered users of Cookie Pal by e-mail and 
by regular postal mail only. You should always check the Kookaburra Software web-site 
(www.kburra.com) before requesting support to make sure you are using the latest version of Cookie Pal
and to view any common support issues which may be on the web-site.

When requesting support please be sure to include the following information:

· Your name and contact information (either e-mail address (preferred) or street address for regular mail).
· What operating system are you using? For example, Windows 95, Windows NT 4.0 etc.
· What version of Cookie Pal are you using? You can select the About option from the Help menu to find 

the version of Cookie Pal you are using.
· If your copy of Cookie Pal is registered, what is your registration number? You can select the About 

option from the Help menu to find this information.
· Nature of the problem?
· Is the problem reproducible?
· If an error message was displayed, please include the full text of the error message.

Requesting support by E-Mail
Please send e-mail to support@kburra.com. Be sure to include the above information

Requesting support by regular mail
Please send mail to the following address:

Kookaburra Software
P.O. Box 23200-394
San Jose,    CA      95153
U.S.A.

Be sure to include the above information.



Cookie Pal License Agreement

By installing Cookie Pal from Kookaburra Software on your computer you agree to the following terms 
and conditions:

· This product is distributed as a SHAREWARE computer software program. You may evaluate this 
product for a maximum of thirty (30) days from the time you first install it onto your computer. After this
time you must either remove this product from your computer or register the product with Kookaburra 
Software.

· This product may be installed on a single computer only and used by one person only.

· Kookaburra Software makes NO WARRANTIES regarding this product. You accept this product on an
AS IS basis. Kookaburra Software is not responsible for any damages whatsoever, including loss of 
information, interruption of business, personal injury and/or any damage or consequential damage 
without limitation, incurred before, during or after the use of our products.

· This program is owned by Kookaburra Software and is copyright protected. No program, code, part, 
image, text or sound may be copied or used in any way by the user except as detailed in this license 
agreement.

· You are permitted to make one (1) back-up copy of the registered program for your personal 
protection. 

· The shareware (unregistered) version of this product may be redistributed freely under the following 
conditions:

à The distribution format is not modified in any way from the original supplied by Kookaburra 
Software. Specifically no files may be altered, deleted or added to the distribution file(s).

à The distribution does not include a registration number.    In particular, you may not distribute 
a registered piece of software.

à No money is charged to the person receiving the software, beyond reasonable cost of 
packaging and other overhead.



Frequently Asked Questions

The items below address some questions which are commonly asked about 'Net Pal. 

The Kookaburra Software web site also has a list of Frequently Asked Questions which may be more 
current than this one. You can access this list using your web browser at http://www.kburra.com and then 
selecting the Support option.

· Cookie Pal does not seem to be working. What can I do?
· When I run my web browser without Cookie Pal I now see annoying dialog boxes asking about 

Cookies.
· How do I turn off the sound which gets played when Cookie Pal encounters a cookie?

Cookie Pal does not seem to be working. What can I do?
Possibility 1
Cookie Pal relies on the warnings which your browser normally displays when a cookie is received. If your
browser does not display these warning messages then Cookie Pal cannot work. You can check to make 
sure that "Cookie Warnings" are enabled for your browser by
following these instructions.

Possibility 2
Cookie Pal needs to know some identifying information about the messages which are displayed by your 
browser when a cookie is received. First read Possibility 1 above to make sure that Cookie Warnings are 
enabled for your browser. You must then navigate to a web site which sets a cookie (such as Andy's 
Netscape HTTP Cookie info...) and note the following items from the Cookie Warning message which is 
displayed by your browser:

· The title of the window.
· The text which appears immediately before the expiration date of the cookie.
· The word "cookie", which should be in the text of the message and may differ depending on the 

language version of your browser.

In Cookie Pal, you can select the "Configure" tab in the main window and enter these details in the dialog 
for either Netscape or Internet Explorer depending on which browser you are using. More information 
about this is available by selecting the Help button while displaying the "Configure" tab in Cookie Pal.

When I run my web browser without Cookie Pal I now see annoying dialog boxes asking about 
Cookies.
Cookie Pal relies on the warnings which your browser normally displays when a cookie is received. These
warning settings are turned on by default when Cookie Pal is installed and whenever a web browser is 
started while Cookie Pal is running. If Cookie Pal is running it will intercept the warning messages for you,
but if you run your web browser without Cookie Pal you may want to turn off these warnings. Be aware 
that by doing this, your web browser will automatically accept all cookies which it receives.

To change the warning settings of your browser, see the Browser Options help topic.



How do I turn off the sound which gets played when Cookie Pal encounters a cookie?
If you have a sound card installed in your system you may want to select this option. Normally when 
Netscape Navigator or Internet Explorer display a cookie alert message you will hear a sound as the 
message box is displayed. When Cookie Pal intercepts the message box it cannot prevent the sound 
from being played at that time.

To disable the sound permanently follow these steps:

1. If the main Cookie Pal window is already displayed, then got to step 4.
2. Right click on the Cookie Pal icon in the taskbar tray.
3. Select Show from the menu which appears to display the main Cookie Pal window.
4. Click on the "Configure" tab with the left mouse button.
5. Click on "Disable alert sound" so that a check is displayed next to the option.

Selecting this option will cause Cookie Pal to permanently disable the sound while both Cookie Pal and a 
web browser are running . The side effect of this is that it will disable the sound for all similar message 
boxes displayed by any other applications in your system. The sound is only disabled while Cookie Pal 
and a browser are running if this option is checked. When you close your browser or Cookie Pal the 
sound setting will be restored in the registry.




